
•  XRef

•  Attach

•  Reload

•  Detach

•  Unload

•  Bind

•  Overlay

•  Underlay

•  Frame

•  Clip

 Key Terms 

Chapter 2
Understanding External 

References

 Learning Objectives 
After completing this chapter, you will be able to:
• Understand external references and their applications
• Understand dependent symbols
• Use the External References Palette
• Use the Attach, Unload, Reload, Detach, and Bind options
• Edit the path of an xref
• Understand the difference between the Overlay and Attachment options
• Use the Attach tool
• Work with Underlays
• Use the DesignCenter to attach a drawing as an xref
• Use the Bind tool to add dependent symbols
• Use the Clip tool to clip xref drawings
• Use the Edit Reference tool for in-place editing
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EXTERNAL REFERENCES			    
The external reference feature allows you to reference an external drawing without making 
that drawing a permanent part of the existing drawing. For example, assume that you have an 
assembly drawing ASSEM1 that consists of two parts, SHAFT and BEARING. The SHAFT and 
BEARING are separate drawings created by two CAD operators or provided by two different 
vendors. You want to create an assembly drawing from these two parts. One way to create an 
assembly drawing is to insert these two drawings as blocks by using the Insert tool in the Block 
panel. Now assume that the design of BEARING has changed due to customer or product 
requirements. To update the assembly drawing, you have to make sure that you insert the 
BEARING drawing after the changes have been made. If you forget to update the assembly 
drawing, then the assembly drawing will not reflect the changes made in the piece part drawing. 
In a production environment, this could have serious consequences.

You can solve this problem by using the external reference facility, which lets you link the piece 
part drawings with the assembly drawing. If the xref drawings (piece part) get updated, the 
changes are automatically reflected in the assembly drawing. This way the assembly drawing 
stays updated, no matter when the changes were made in the piece part drawings. There is no 
limit to the number of drawings that you can reference. You can also have nested references. For 
example, the piece part drawing BEARING could be referenced in the SHAFT drawing, and 
the SHAFT drawing could be referenced in the assembly drawing ASSEM1. When you open or 
plot the assembly drawing, AutoCAD automatically loads the referenced drawing SHAFT and 
the nested drawing BEARING. While using external references, several people working on the 
same project can reference the same drawing and all the changes made are displayed everywhere 
the particular drawing is being used.

If you use the Insert tool to insert the piece parts, the piece parts become a permanent part 
of the drawing, and therefore, the drawing file size increases. However, if you use the external 
reference feature to link the drawings, the piece part drawings are not saved with the assembly 
drawing. AutoCAD only saves the reference information with the assembly drawing; therefore, 
the size of the drawing is minimized. Like blocks, the xref drawings can be scaled, rotated, or 
positioned at any desired location, but they cannot be exploded. You can also use only a part of 
the xref by making clipped boundary of xrefs. 

Tip 
External referenced drawings are useful for creating parts or subassemblies and then putting 
them together in one drawing to create the main assembly. You can also use it for laying out 
the contents of a drawing with multiple views before plotting.

DEPENDENT SYMBOLS
When you use the Insert tool to insert a drawing, the information about the named objects 
is lost, if names are duplicated. However, if they are unique, they are imported. The named 
objects are entries such as blocks, text styles and layers. For example, if the assembly drawing 
has a layer Hidden of green color and HIDDEN linetype and the piece part Bearing has also a 
layer Hidden of blue color and HIDDEN2 linetype, the values set in the assembly drawing will 
override the values of the inserted drawing when the Bearing drawing is inserted in the assembly 
drawing, refer to Figure 2-1. As a result, in the assembly drawing, the layer Hidden will retain 
green color and HIDDEN linetype, ignoring the layer settings of the inserted drawing. Only 
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those layers that have the same names are affected. The remaining layers that have different 
layer names are added to the current drawing.

Figure 2-1  Partial view of the layer settings of the current drawing in the LAYER 
PROPERTIES MANAGER

In the xref drawings, the information about the named objects is not lost because AutoCAD will 
create additional named objects such as specified layer settings, as shown in Figure 2-2. For xref 
drawings, these named objects become dependent symbols (features such as layers, linetypes, 
object color, text style, and so on).

Figure 2-2  Additional layers created by xref

The layer Hidden of the xref drawing (Bearing) is appended with the name of the xref drawing 
Bearing, and the two are separated by the vertical bar symbol (|). The names of these layers 
appear in light gray color in the LAYER PROPERTIES MANAGER or Layer drop-down list of 
the Layers panel in the Home tab. These layers can neither be selected nor be made current. The 
layer name Object changes to Bearing|Object. Similarly, Center is renamed as Bearing|Center, 
refer to Figure 2-2. The information added to the current drawing is not permanent. It is added 
only when the xref drawing is loaded. If you detach the xref drawing, the dependent symbols 
are automatically erased from the current drawing.

When you xref a drawing, AutoCAD does not let you reference the symbols directly. For example, 
you cannot make the dependent layer, Bearing|Object, as current layer. Therefore, you cannot 
add any objects to that layer. However, you can change the color, linetype, lineweight, plotstyle, 
or visibility (on/off, freeze/thaw) of the layer in the current drawing. 



2-4		         Advanced AutoCAD 2023: A Problem-Solving Approach, 3D and Advanced
	

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Note
You cannot make the xref-dependent layers current in a drawing. When the xref drawing is bound 
to the current drawing by using the XBIND command, only then you can make the xref-dependent 
layers a permanent part of the current drawing and use them. The XBIND command will be 
discussed later in this chapter.

MANAGING EXTERNAL REFERENCES IN A DRAWING                           
  Ribbon:  View > Palettes > External References Palette				    	  
  Toolbar:  Reference > 	External References			   Command:  XREF	  
  Menu Bar:  Insert > External References						    

When you choose the External References Palette button from the Palettes panel of the 
View tab, refer to Figure 2-3, AutoCAD displays the EXTERNAL REFERENCES palette, 

as shown in Figure 2-4. The EXTERNAL REFERENCES palette displays the status of each Xref 
in the current drawing and the relation between various Xrefs. It allows you to attach a new xref 
and detach, unload, and load an existing one, change an attachment to an overlay, or an overlay 
to an attachment. You can also open a reference drawing for editing from this palette. Additionally, 
it allows you to edit an xref ’s path and bind the xref definition to the drawing. 

Figure 2-3  The Palettes panel

Apart from the methods mentioned in the command box, you can also invoke the EXTERNAL 
REFERENCES palette by selecting an xref in the current drawing and then right-clicking in the 
drawing area to display a shortcut menu. Next, choose External References from the shortcut 
menu; the EXTERNAL REFERENCES palette will be displayed. 

The upper right corner of the palette has two buttons: List View and Tree View.

List View
When you choose the List View button, the xrefs present in the drawing are displayed in 
alphabetical order. This is the default view. The list view displays information about xrefs in the 
current drawing under the following headings:

Reference Name
This column lists the name of all existing references in the current drawing.
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Status
This column lists the current status of each xref in the drawing.

Figure 2-4  The EXTERNAL 
REFERENCES palette

 
It lists whether an xref is loaded, unloaded, unreferenced, not 
found, orphaned, unresolved, or marked to be reloaded. A 
loaded xref implies that the xref is attached to the current 
drawing. You can then unload it and then reload it using the 
options in the dialog box (this will be discussed later). An xref 
selected to be unloaded or reloaded displays Unload and 
Needs reloading respectively, under the Status column. If the 
xref has nested references that cannot be found, the status is 
Unreferenced, and if the parent of the nested reference gets 
unloaded, or cannot be found, its status is described as 
Orphaned. An unreferenced xref will not be displayed. If the 
xref is not found in the search paths defined, its status is Not 
Found. A missing xref or one that cannot be found is 
Unresolved.

Size
The file size of each xref is listed here.

Type
This column lists whether the xref is an attachment or overlay.

Date
This column lists the date on which the xref drawing was last 
saved.

Saved Path
This column lists the path of the xref, that is, the route taken to locate the particular referenced 
drawing.

Choose any of these headings; AutoCAD sorts and lists the Xrefs in the current drawing according 
to that particular title. For example, on choosing Reference Name, the xrefs are sorted and listed 
as per the name. The column widths can be increased or decreased as per your requirements. 
When you place your cursor at the edge of a column title button, the cursor changes to a horizontal 
resizing cursor. Now, press the pick button of your mouse and drag the column edge to increase 
or decrease its width. After you increase the column widths, it is possible that the widths of the 
columns extend beyond the widths of list boxes. In such a case, a horizontal scroll bar appears 
at the bottom of the list box. You can use the scroll bar to view the columns that extend beyond 
the width of the list box.

Tree View
On choosing the Tree View button available in the right side of the File References title bar, 
the xrefs are displayed in a hierarchical tree view in the EXTERNAL REFERENCES palette. It 
displays information on nested xrefs and their relationship with one another. Xrefs are indicated 
by an icon of a paper with a paper clip. This icon appears with a cross mark when the xref gets 
unloaded, and if there is a missing xref, the “!” sign appears. Similarly, the arrow pointing 
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downward indicates that the xref is unloaded. You can also choose List View and Tree View by 
pressing the F3 and F4 keys, respectively. 

Attaching an Xref Drawing (Attach Option)
The Attach drop-down list is available at the upper left corner of the EXTERNAL REFERENCES 
palette. If you choose the down arrow on this button, a flyout will be displayed. Choose the 
Attach DWG option from the Attach drop-down list to attach an xref drawing to the current 
drawing. This option can also be invoked by right-clicking on

Figure 2-5  Drawing of SHAFT

 
the File References area. The following examples illustrate 
the process of attaching an xref to the current drawing. In 
this example, it is assumed that there are two drawings, 
SHAFT and BEARING. SHAFT is the current drawing that 
is loaded on the screen, as shown in Figure 2-5 and the 
BEARING drawing is saved on the disk. If you want to xref 
the BEARING drawing in the SHAFT drawing, you need to 
follow the steps given below:

1.	 The first step is to make sure that the SHAFT drawing 
is on the screen (draw the shaft drawing with assumed 
dimensions). 

Tip 
No drawing needs to be on the screen. You could attach both drawings, BEARING and SHAFT 
to an existing drawing, even if it is a blank drawing.

2. 	 Choose the External References Palette button from the Palettes panel to display the 
EXTERNAL REFERENCES palette. In this palette, choose the Attach DWG option; the 
Select Reference File dialog box will be displayed.

 	 Select the drawing that you want to attach (BEARING) and then choose the Open button; 
the Attach External Reference dialog box will be displayed, as shown in Figure 2-6. In this 
dialog box, the name of the file that you have selected to be attached to the current drawing 
as an xref is displayed in the Name drop-down list. You can also specify the name of the file 
to be attached from the Name drop-down list.

Note
AutoCAD also searches for the xref file in the paths defined in the Project Files Search Path folder 
in the Files tab of the Options dialog box. This folder does not have any path defined in it and 
displays Empty when the tree view is expanded. To define a search path, select Empty and choose 
the Add button in the dialog box. You can enter a project name here, if you want. Now, expand 
the tree view, select Empty again, and choose the Browse button; the Browse for Folder window 
is displayed. Select the folder that is to be searched for the file and choose the OK button. Then, 
choose the Apply button and the OK button from the Options dialog box to exit it.
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Figure 2-6  The Attach External Reference dialog box

In the Reference Type area, select the Attachment radio button, if it is not selected by default. 
The Overlay option is discussed later in this chapter. The Path type drop-down list is used to 
specify whether you want to attach a drawing with full path, relative path, or no path. If you 
select the Full path option, the precise location of the xreffed drawing is saved. If you select the 
Relative path option (if not selected by default), the position of the xreffed drawing with reference 
to the host drawing is saved. If you select the No path option, AutoCAD will search for the 
xreffed drawing in only that folder in which the host drawing is saved. You can also specify the 
insertion point, scale factors, and rotation angle in the respective X, Y, Z, and Angle edit boxes 
or select the Specify On-screen check boxes to use the pointing device to specify them on the 
screen. By default, the scale factors in X, Y, and Z edit boxes is 1 and the rotation angle is 0. 
The Block Unit area provides information regarding the units of the inserted block. The Unit 
edit box displays the unit of the block. The Factor edit box displays the scale factor, depending 
on the unit of the block and that of the current drawing.

Figure 2-7  Attaching the BEARING 
drawing as an xref 

 
If you choose the Show Details button, the path of the 
file is displayed adjacent to Found in. Also, the saved 
path of the file is displayed adjacent to Saved path. 
Choose the OK button from the Attach External 
Reference dialog box to accept the default values and 
exit the dialog box. Specify the insertion point; the 
drawing is attached to the current drawing, but it appears 
faded. After attaching the BEARING drawing as an xref, 
save the current drawing with the file name SHAFT, as 
shown in Figure 2-7. You can control the fading intensity 
of the attached objects by using the options from the 
Fade control area of the Display tab in the Options 
dialog box. In this area, you can either use the slider bar 
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to increase or decrease the fading intensity or you can enter a value in the edit box. You can 
also use the XDWGFADECTL variable to control the fading intensity of other objects while 
editing them. By default, the fading intensity value is set to 50.

Note
In AutoCAD, you can also control the Path type by using REFPATHTYPE system variable. This 
system variable has three values which are given next:

0=No path
1=Relative path (default value)
2=Full path

You can also change the Path type of an existing xreffed drawing by first invoking a shortcut menu 
by right-clicking on the name of xreffed drawing from EXTERNAL REFERENCES palette and 
then choosing the desired path type from the Change Path Type cascading menu.

3.	 Open the BEARING drawing and make the changes shown in Figure 2-8 (draw polylines 
on the sides). Now, save the drawing with the file name BEARING.

4.    Open the SHAFT drawing. In the EXTERNAL REFERENCES palette, you will notice that
      the message Needs reloading  displayed in the Status column of the BEARING drawing.   

Right-click on BEARING and choose Reload; the BEARING drawing is automatically 
     updated, refer to Figure 2-9. This is the most useful feature of external reference. You
         can insert the drawing as a block also, but in that case any modification made in the drawing    
   	 will not reflect automatically in the drawing in which it is inserted.               
    

Figure 2-8  The modified 
xref BEARING drawing

Figure 2-9  BEARING drawing automatically 
updated after loading the SHAFT drawing

However, when you make modifications in a large drawing file, it is not easy to find out where
the modification were made. AutoCAD 2023 comes with Xref Compare bar that helps you detect
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the changes made in the xref drawings. Whenever you modify a drawing and click on the Modify 
option, the Xref Compare bar with modified drawing will be displayed, as shown in Figure 2-10.

Figure 2-10  The Xref Compare bar with modified drawing 

You will notice that the by default, the identical part between the two drawings is displayed in
gray color. The elements which have been modified are displayed in green color.

In the Xref Compare bar, a number of parameters can be set to change the appearance of the
modified elements using the tools in the Settings button. For example, if you want to change the
color of the modified elements into blue, choose green color from color swatch in the Difference
area; the  Select Color dialog box will be displayed. In this dialog box, select blue color and 
choose the OK button; the color of the modified element will change into blue. You can also 
turn On/Off the visibility of the respective elements using the Visibility toggle button available 
on the left of the color swatch in the Difference area.
	
Now once you attach an xref drawing, AutoCAD remembers the name of the attached drawing
If you xref the drawing again, AutoCAD displays a message as given next.
Xref “BEARING” has already been defined.
Using existing definition.
Specify insertion point or [Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]: Specify the location to
place another copy of the xref.

Note
If the external reference drawing that you want to attach is currently being edited, AutoCAD 
will attach the drawing that was last saved through the Save, Write Block, or Exit Autodesk 
AutoCAD 2023 buttons.

Points to Remember about Xref
1.	 When you enter the name of the xref drawing, AutoCAD checks for block names and xref 

names. If a block exists with the same name as the name of the xref drawing in the current 
drawing, the Attach tool is terminated and an error message is displayed.

2.	 When you xref a drawing, the objects that are in the model space are attached. Any objects 
that are in the paper space are not attached to the current drawing.
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3.	 The layer 0, DEFPOINTS, and the linetype CONTINUOUS are treated differently. The 
current drawing layers 0, DEFPOINTS, and linetype CONTINUOUS will override the 
layers and linetypes of the xref drawing. For example, if the layer 0 of the current drawing 
is white and the layer 0 of the xref drawing is red, the white color will override the red.

4.	 The xref drawings can be nested. For example, if the BEARING drawing contains the 
reference INRACE and you xref the BEARING drawing to the current drawing, the INRACE 
drawing is automatically attached to the current drawing. If you detach the BEARING 
drawing, the INRACE drawing gets detached automatically.

5.	 You can rename an xref under the File References column name in the list box of the 
EXTERNAL REFERENCES palette by double-clicking on the xref. You can now enter a new 
name. An AutoCAD warning is displayed: Caution! “XXXX” is an externally referenced 
block. Renaming it will also rename its dependent symbols.

6.	 When you xref a drawing, AutoCAD stores the name and path of the drawing by default. If 
the name of the xref drawing or the path where the drawing was originally stored has changed 
or you cannot find it in the path specified in the Options dialog box, AutoCAD cannot load 
the drawing, plot it, or use the Reload option of the EXTERNAL REFERENCES palette.

Detaching an Xref Drawing (Detach Option)
The Detach option can be used to detach or remove the xref drawings. If there are any nested 
xref drawings defined with the xref drawings, they are also detached. Once a drawing is detached, 
it is erased from the screen. To detach an xref drawing, select the file name in the EXTERNAL 
REFERENCES palette list box to highlight it and then right-click on it, a flyout will be displayed. 
Next, choose the Detach option from the flyout, the xref is completely removed from the current 
drawing. 

Updating an Xref Drawing (Reload Option)
When you load a drawing, AutoCAD automatically loads the referenced drawings. The Reload 
option of the EXTERNAL REFERENCES palette lets you update the xref drawings and nested 
xref drawings at any time. You do not need to exit the drawing editor and then reload the 
drawing. To reload the xref drawings, invoke the EXTERNAL REFERENCES palette, select 
the xreffed drawing in the list box, and then right-click on it to choose the Reload option from 
the shortcut menu. AutoCAD will scan for the referenced drawings and the nested xref drawings 
and load the most recently saved version of the drawing.

You can reload all the attached xref drawings at one time by selecting Reload All References 
from the drop-down list of the Refresh button on the upper left corner of the EXTERNAL 
REFERENCES palette. 

The Reload option is generally used when the xref drawings are currently being edited and 
you want to load the updated drawings. The xref drawings are updated based on what is saved 
on the disk. Therefore, before reloading an xref drawing, you should make sure that the xref 
drawings that are being edited have been saved. If AutoCAD encounters an error while loading 
the referenced drawings, the External References tool is terminated, and the entire reload 
operation is canceled.
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Unloading an Xref Drawing (Unload Option)
The Unload option allows you to temporarily remove the definition of an xref drawing from 
the current drawing. However, AutoCAD retains the pointer to the xref drawings. When you 
unload the xref drawings, the drawings are not displayed on the screen. You can reload the xref 
drawings by using the Reload option. 

Tip 
It is recommended that you unload the referenced drawings if they are not being used. After 
unloading the xref drawings, the drawings load much faster and need lesser memory.

Adding an Xref Drawing (Bind Option)
The Bind option lets you convert the xref drawings to blocks in the current drawing. The bound 
drawings, including the nested xref drawings (that are no longer xrefs), become a permanent 
part of the current drawing. The bound drawing cannot be detached or reloaded. You can use 
this option when you want to send a copy of your drawing to a customer for review. Because the 
xref drawings are a part of the existing drawing, you do not need to include the xref drawings 
or the path information. You can also use this option to

Figure 2-11  The Bind Xrefs/DGN 
underlays dialog box

 
safeguard the master drawing from accidental editing of 
the piece parts. To bind the xref drawings, select the file 
names in the EXTERNAL REFERENCES palette and then 
right-click and choose the Bind option from the shortcut 
menu; the Bind Xrefs/DGN underlays dialog box is 
displayed, as shown in Figure 2-11. AutoCAD provides two 
methods to bind the xref drawing in the Bind Type area of 
the dialog box. These methods are discussed next.

Bind
When you use the Bind radio button, AutoCAD binds the selected xref definition to the current 
drawing. All the xrefs are converted to blocks and the named objects are renamed. For example, 
if you xref the drawing Bearing with a layer named Object, a new layer Bearing|Object is created 
in the current drawing. When you bind this drawing, the xref dependent layer Bearing|Object 
will become a locally defined layer Bearing$0$ Object, refer to Figure 2-12. If the Bearing$0$ 
Object layer already exits, AutoCAD will automatically increment the number, and the layer 
name becomes Bearing$1$Object.

Figure 2-12  Partial view of the LAYER PROPERTIES MANAGER
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Insert
When you use the Insert radio button, AutoCAD inserts the xref drawing. The xrefs get converted 
into blocks. For example, if you xref the drawing Shaft with a layer named Object, a new layer 
Shaft|Object is created in the current drawing. If you use the Insert option to bind the xref 
drawing, the layer name Shaft|Object is renamed as Object. If the object layer already exists, 
then the values set in the current drawing override the values of the inserted drawing. 

Editing an XREF’s Path
By default, AutoCAD saves the path of the referenced drawing and displays it in the Saved 
Path column of the EXTERNAL REFERENCES palette. As mentioned earlier, when AutoCAD 
loads the drawing containing a referenced file, and if it is not able to find the file at the location 
specified in the Saved Path column of the EXTERNAL REFERENCES palette, it searches for 
the file in the current directory, and in the Support File Search Path locations specified in the 
Files tab of the Options dialog box. If a file with the same name is found, it is loaded. Now, when 
you invoke the EXTERNAL REFERENCES palette, you will notice that if you select an xref 
name in the list box to highlight it, the path displayed in the Found At column for the xref file 
is different from the one displayed in the Saved Path edit box. To update the path of the xref 
file, choose the Browse button. The new path is saved and displayed in the Found At column.

If AutoCAD is unable to locate the specified file even in the directories specified in the Files 
tab of the Options dialog box, it will display an error message saying that it cannot find the 
specified file. The path of the file is displayed as a marker text in the current drawing. Now, 
when you invoke the EXTERNAL REFERENCES palette, the status of the drawing is shown 
as Not Found. To specify a new path for the xref file, click in the Saved Path field; the path will 
be highlighted and the Browse button will be displayed next to the path. Click on this button; 
the Select new path dialog box will be displayed. Using this dialog box, you can locate the 
drawing to be used as xref. Once you have found the file, choose the Open button to return to 
the EXTERNAL REFERENCES palette. The new path is displayed in the Found At column 
and the Saved Path edit box. The specified xref file is reloaded and replaces the marker text in 
the drawing, when you choose the OK button in the EXTERNAL REFERENCES palette. If you 
remember the new location of the xref file, you can also enter it in the Saved Path edit box. For 
example, if a drawing, which was originally in the C:\CAD\Proj1 subdirectory, has been moved 
to C:\Parts directory, the path must be edited so that AutoCAD is able to load the xref drawing. 

In AutoCAD, you can assign new path to the xreffed file whose path is missing by choosing 
the Select New Path option from the shortcut menu invoked by right clicking on the name of 
xreffed drawing from EXTERNAL REFERENCES palette. You can also assign the same path 
to every file whose path is missing using this tool.

You can change the path of various xreffed drawings having same path by choosing the Find 
and Replace option from the shortcut menu invoked by right-clicking on the name of xreffed 
drawing from EXTERNAL REFERENCES palette and assign new path to all the drawings at 
once.

THE OVERLAY OPTION						       
As discussed earlier, when you attach an xref to a drawing, the Attach External Reference dialog 
box is displayed. The Reference Type area of this dialog box has two radio buttons, Attachment 
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and Overlay. You can select any of these radio buttons to xref a drawing. The Attachment radio 
button is selected by default. The advantage of selecting the Overlay radio button is that you 
can access the desired drawing instead of the drawing along with its xreffed attachments. For 
example, consider three people working on three different drawings that are a part of the same 
project. The first designer is working on the layout of walls of a room, the second designer 
is working on the furniture layout of the room, and the third on the electrical layout of that 
room. The names of the drawings are WALLS, FURNITURE, and ELECTRICAL, respectively. 
Assume that the designer working on the walls layout selects the Attachment radio button to 
xref the FURNITURE drawing so that he or she can check the furniture layout according to 
the wall structure. After insertion, the WALLS drawing will comprise the wall structure (current 
drawing) along with the furniture layout (xreffed drawing). Now, if the designer working on the 
electrical layout xrefs the WALLS drawing to check the location of electrical fittings with respect 
to the walls, he/she will get the drawing that has the furniture layout as well as the wall layout. 
This is because the FURNITURE drawing was xreffed in the WALLS drawing by selecting the 
Attachment radio button.

In this example, the designer working on the ELECTRICAL drawing may not require the 
FURNITURE drawing. This is because at this stage, the designer will be more interested in 
checking the electrical fittings with respect to the wall structure. So the furniture layout that is 
xreffed with the wall structure needs to be avoided. This can be done by selecting the Overlay 
radio button while X-referencing the FURNITURE drawing in the WALLS drawing. This means 
that the designer working on the wall structure needs to xref the furniture layout by selecting the 
Overlay radio button. Now, if the wall structure is xreffed in some other drawing, the furniture 
layout will not appear.

One of the problems of using the Attachment option is that you cannot have a circular reference. 
For example, assume you are designing the plant layout of a manufacturing unit. One person 
is working on the floor plan, refer to Figure 2-13, and the second person is working on the 
furniture layout in the offices, refer to Figure 2-14. The names of the drawings are FLOORPLAN 
and OFFICES, respectively. The person working on the

Figure 2-13  Hierarchy of 
FLOORPLAN drawing

 
office layout uses the Attachment option to insert the 
FLOORPLN drawing so that he or she has the latest floor 
plan drawing. The person who is working on the floor 
plan wants to reference the OFFICES drawing. 

Now, if the Attachment option is used to reference the 
drawings, AutoCAD displays an error message. This is 
because by attaching the OFFICES drawing, a circular 
reference is created. The AutoCAD message displayed is 
“Circular references detected. Continue?”, as shown in 
Figure 2-15. If you choose the No button, the External 
References Palette tool is canceled and no drawing is 
referenced. But if you choose the Yes button, the following 
message Breaking circular reference from “offices” to “current drawing” is displayed at 
command line and the particular file you wanted to reference gets referenced.
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Figure 2-14  Hierarchy of OFFICES drawing Figure 2-15  The AutoCAD 
Alert message box

However, to overcome this problem of circular reference, you can use the Overlay option to 
overlay the OFFICES drawing. This is a very useful option because the Overlay option allows 
different operators avoid circular reference and share the drawing data without affecting the 
drawing. Overlaying allows you to view a referenced drawing without having to attach it to the 
current drawing. This option can be invoked by selecting the Overlay radio button in the Attach 
External Reference dialog box, which is displayed after you have selected a drawing to reference. 
Also, when a drawing that has a nested overlay is overlaid, the nested overlay is not visible in the 
current drawing. This is another difference between attaching an xref and overlaying an xref to 
a drawing. This feature is especially useful when you want to reference a drawing that another 
user who is referencing your drawing does not need. Although the attachment will reference 
the nested reference too, the overlay option ignores nested references.

In AutoCAD, you can change an external referenced file from attachment to overlay and 
vice-versa. To do so, select the file from the EXTERNAL REFERENCES palette and right-click 
on it; a shortcut menu will be displayed, refer to Figure 2-16. Hover the cursor on the Xref 
Type option in the shortcut menu; two options are displayed, Attach and Overlay. Select the 
option as per requirement. The selected file will become attachment or overlay as per the 
option selected. You can change the type of multiple reference files by selecting all of them and 
then right-clicking on them.

Figure 2-16  The shortcut menu
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Example 1 				        Attachment and Overlay 
In this example, you will use the Attachment and Overlay options to attach and reference 
the drawings. Two drawings, PLAN and PLANFORG are given. The PLAN drawing, refer to 
Figure 2-17, consists of the floor plan layout, and the PLANFORG drawing, refer to Figure 2-18 
has the details of the forging section only. The CAD operator who is working on the PLANFORG 
drawing wants to xref the PLAN drawing for reference. Also, the CAD operator working on the 
PLAN drawing should be able to xref the PLANFORG drawing to complete the project. The 
following steps illustrate how to accomplish the defined task without creating a circular reference.

Download these files from https://www.cadcim.com. The path of the file is as follows: Textbooks 
> CAD/CAM > AutoCAD Advanced > Advanced AutoCAD 2023: A Problem-Solving Approach, 3D 
and Advanced > Input Files.

Figure 2-17  The PLAN drawing Figure 2-18  The PLANFORG drawing

How circular reference is caused?

1.	 Open the drawing PLANFORG and then choose the External References Palette button 
from the Palettes panel in the View tab. Next, choose the Attach DWG option from the 
EXTERNAL REFERENCES palette; the Select Reference File dialog box is displayed. Select 
the PLAN drawing from the list box of the Select Reference File dialog box and choose the 
Open button; the Attach External Reference dialog box is displayed. In this dialog box, the 
name of the PLAN drawing is displayed in the Name edit box, and the Attachment radio 
button is selected by default in the Reference Type area. Choose the OK button to exit the 
dialog box and specify an insertion point on the screen. Now, the drawing consists of the 
PLANFORG and PLAN. Save the drawing.

2.	 Open the drawing file PLAN. Next, choose the External References Palette button and 
attach the PLANFORG drawing to the PLAN drawing using the same steps as described 
in Step 1. AutoCAD will display the message that the circular reference has been detected 
and will ask you if you want to continue. If you choose Yes in the AutoCAD message box, 
the circular reference is broken and you are allowed to reference the specific drawing.



2-16		         Advanced AutoCAD 2023: A Problem-Solving Approach, 3D and Advanced
	

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

	 The possible solution for the operator working on the PLANFORG drawing is to detach 
the PLAN drawing. This way the PLANFORG drawing does not contain any reference to 
the PLAN drawing and would not cause any circular reference. The other solution is to use 
the Overlay option, as follows:

How to prevent circular reference?

3.	 Open the PLANFORG drawing, refer to Figure 2-19 and select the Overlay radio button in 
the Attach External Reference dialog box, which is displayed after you have selected the 
PLAN drawing to reference. The PLAN drawing is overlaid on the PLANFORG drawing, 
refer to Figure 2-20. Save the drawing.

Figure 2-19  The PLANFORG drawing Figure 2-20  The PLANFORG drawing after 
overlaying the PLAN drawing

4.	 Open the drawing file PLAN, refer to Figure 2-21, and select the Attachment radio button 
in the Attach External Reference dialog box, which is displayed when you select the 
PLANFORG drawing in the Select Reference File dialog box to attach it as an xref to the 
PLAN drawing. You will notice that only the PLANFORG drawing is attached, refer to 
Figure 2-22. The drawing that was overlaid in the PLANFORG drawing (PLAN) does not 
appear in the current drawing. This way, the CAD operator working on the PLANFORG 
drawing can overlay the PLAN drawing, and the CAD operator working on the PLAN 
drawing can attach the PLANFORG drawing, without causing a circular reference.

Figure 2-21  The PLAN drawing Figure 2-22  The PLAN drawing after 
attaching the PLANFORG drawing
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ATTACHING FILES TO A DRAWING
  Ribbon:  Insert > Reference > Attach		  Command: ATTACH    

You can use the Attach tool in the Reference panel,

Figure 2-23  The Attach tool in the 
Reference panel

 
refer to Figure 2-23, to attach a DWG, DGN, DWF, 

PDF, Autodesk Point Cloud files, Navisworks files, or image 
file without invoking the EXTERNAL REFERENCES 
palette. Using this tool, you can attach a drawing file easily, 
since most of the xref operations involve simply attaching 
a drawing file. When you invoke this tool, AutoCAD 
displays the Select Reference File dialog box. To attach a 
.dwg, .dgn, .dwf, .pdf, .rcp, rcs, .nwc, .nwd, or image file, specify it in the Files of type drop-down 
list in the Select Reference File dialog box; the corresponding files will be listed in the dialog 
box. Select the drawing file to be attached and choose the Open button; the Attach External 
Reference dialog box is displayed. Select the Attachment radio button (if not selected by default) 
under the Reference Type area. You can specify the insertion point, scale, and rotation angle 
on screen or in the respective edit boxes. 

Note
1. To select a .dgn, .dwf, .pdf, or image file, specify the file type in the Files of type drop-down list 
in the Select Reference File dialog box; the files will be attached as an underlay. Underlays are 
discussed in the next section.

2. AutoCAD maintains a log file (.xlg) for xref drawings if the XREFCTL system variable is set 
to 1. This file lists information about the date and time of loading and other xref operations to 
be completed. This .xlg file is saved in the current drawing with the same name as the current 
drawing and is updated each time the drawing is loaded or any xref operations are carried out.

WORKING WITH UNDERLAYS
You can attach a DWF, DGN, or PDF file as an underlay to the current drawing file. The underlay 
files are not a part of original drawing files. Therefore, if you add a file as an underlay, it does 
not increase the file size of the current drawing. The procedure to add a file as an underlay is 
similar to attaching a drawing file using the Attach tool. After you select the file to attach, the 
Attach <XXXX> Underlay dialog box will be displayed, where <XXXX> is the file type. 
Figure 2-24 shows the Attach PDF Underlay dialog box that is displayed on selecting a pdf file 
from the Select Reference File dialog box.

If the selected .pdf file has multiple pages, all pages of the pdf file are listed in the Select one or 
more pages from the PDF file area. Select the pages to be attached from this area. If you have 
selected multiple pages as well as the Specify on-screen check box from the Insertion point 
area, then you are prompted to specify different insertion points for different pages. 

The files attached as an underlay behave like blocks. The general modify commands like move, 
copy, rotate, mirror, and so on can be applied on them. However, you cannot bind a file that is 
attached as an underlay or modify the attached file in the current drawing file.
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Figure 2-24  The Attach PDF Underlay dialog box

Editing an Underlay
As discussed earlier, you cannot edit a file that is attached as an underlay. However, you can 
control the appearance of the underlay by adjusting the contrast, fade, and monochrome display. 
To do so, select the attached object; a contextual tab will be displayed. Figure 2-25 shows the 
PDF Underlay tab that is displayed on selecting a PDF file. 

Figure 2-25  The PDF Underlay tab

You can use the options in this contextual tab to adjust the fade, contrast, and monochrome 
display of the underlay. You can create a new clipping boundary similar to that of an attached 
drawing. By default, the Enable Snap button is chosen in the Options panel. Therefore, you 
can snap entities in the underlaid object. If you deselect this button, you cannot snap entities 
in the underlaid objects. You can use the Show Underlay button from the Options panel to 
display/hide the underlaid objects. Both Enable Snap and Show Underlay are toggle buttons. 
If the attached underlay has layers, you can hide/display the selected layers. To do so, choose 
the Edit Layers button from the PDF Layers panel of the PDF Underlay contextual tab; the 
Underlay Layers dialog box will be displayed, as shown in Figure 2-26. If multiple drawings 
are attached as an underlay, all file names will be listed in the Reference Name drop-down list. 
Select the file from the Reference Name drop-down list for which you need to hide the layers; 
the corresponding layers will be listed in the list box. Click on the bulb icon of the layer to be 
hidden. Alternatively, select the layer from the list box and right-click; a shortcut menu will be 
displayed. Choose the Layer(s) Off option to hide the selected layer. To hide multiple layers, 
press the CTRL key and select the layers to be hidden. Next, choose Layer(s) Off. Then, choose 
the OK button to exit the Underlay Layers dialog box. 
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Figure 2-26  The Underlay Layers dialog box

If you have attached a file as an underlay, you can invoke the Underlay Layers dialog box without 
invoking the contextual tab by choosing the Underlay Layers tool from the Reference panel 
in the Insert tab. Similarly, you can switch on/off the OSNAP settings for the drawing that are 
underlaid by choosing the Snap to Underlays ON / Snap to Underlays OFF tool, respectively 
from the Snap to Underlays drop-down in the Reference panel. You can import the geometry, 
fills and hatches, raster images, and TrueType text objects from a specified PDF file by choosing 
the Import as Objects button from the PDF Import panel of the PDF Underlay contextual tab. 

Note
If there are more underlays of different file types and you have set different osnap setting for each 
file type, then the Underlay Osnap’s Vary tool will be activated in the Snap to Underlays 
drop-down in the Reference panel. However, if you choose the Snap to Underlays ON / Snap 
to Underlays OFF tool, the corresponding osnap setting will be applied to all underlays.

OPENING AN XREFFED OBJECT IN A SEPARATE 
WINDOW
If you are in the host drawing and you want to open a selected xreffed object in a separate window 
without using the Select File dialog box, you can use the Open Reference tool available in the 
External Reference contextual tab which is displayed on selecting an external reference. Select 
the xreffed object that you want to open in a separate window. When you select the desired xref, 
AutoCAD opens the DWG file of the xreffed object in a separate window. You can now make 
the desired changes in the DWG file of the xreffed object. Save the changes and then close 
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the drawing. When you open the host drawing, you will notice that the Manage xrefs displays 
a message that the external reference file has changed and the xreffed drawing needs to be 
reloaded. Reload the xreffed drawing using the EXTERNAL REFERENCES palette and you 
will notice that the host drawing is updated.

USING THE DesignCenter TO ATTACH A DRAWING AS 
AN XREF
The DESIGNCENTER can also be used to attach an xref to a drawing. To do so, choose the 
DesignCenter button from the Palettes panel in the View tab; the DESIGNCENTER palette 
will be displayed. In the DESIGNCENTER palette, choose the Tree View Toggle button, if it 
is not chosen already, to display the tree pane. Expand the Tree view and double-click on the 
folder whose contents you want to view. The contents of the selected folder are displayed in the 
palette. From the thumbnails of drawings displayed on the right-side of the palette, right-click 
on the drawing to be attached as an xref; a shortcut menu is displayed, refer to Figure 2-27. 
Choose Attach as Xref from the shortcut menu; the Attach External Reference dialog box 
will be displayed. Alternatively, you can also use the right mouse button to drag and drop the 
drawing into the current drawing; a shortcut menu will be displayed. Choose the Create Xref 
option to insert the drawing as an xref. 

Figure 2-27  The shortcut menu displayed

In the Attach External Reference dialog box, the Name drop-down displays the name of the 
selected file to be inserted as an xref. Select the Attachment radio button in the Reference Type 
area, if not already selected. Specify the Insertion point, Scale, and Rotation in the respective 
edit boxes or select the Specify On-screen check boxes to specify this information on the screen. 
Choose the OK button to exit the dialog box; the selected object is attached as an xref to the 
current drawing.
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ADDING XREF DEPENDENT NAMED OBJECTS
  Menu Bar:  Modify > Object > External Reference > Bind	  
  Toolbar:  Reference > Xbind	           Command:  XB/XBIND  	

You can use the Xbind tool to add the selected named objects such as blocks, dimension 
styles, layers, line types, and text styles of the xref drawing to the current drawing. The 
following example describes the use of this command.

1.	 Load the drawing Bearing that was created earlier. Make sure the drawing has the following 
layer setup. Otherwise, create the following layers using the LAYER PROPERTIES 
MANAGER.

Layer Name	             Color	 Linetype	

	 0			   White		  Continuous

	 Object		  Red		  Continuous

	 Hidden		  Blue		  Hidden2

	 Center		  White		  Center2

	 Hatch		  Green		  Continuous

2.	 Draw a circle and create it as a block with the name SIDE. Save the drawing as Bearing.

3.	 Start a new drawing with the following layer setup:

Layer Name	            Color	 Linetype	

	 0			   White		  Continuous

	 Object		  Red		  Continuous

	 Hidden		  Green		  Hidden

4.	 Use the Attach tool in the Reference panel to attach the Bearing drawing to the current 
drawing. When you xref the drawing, the layers will be added to the current drawing, as 
discussed earlier in this chapter.

5.	 Now, invoke the Xbind tool; the Xbind dialog box is displayed. This dialog box has two 
areas with list boxes. They are Xrefs and Definitions to Bind. If you want to bind the 
blocks defined in the xref drawing Bearing, first click on the plus sign adjacent to the xref 
Bearing; the icons for the named objects in the drawing are displayed in a tree view, refer to 
Figure 2-28. Click on the plus sign next to the Block icon. AutoCAD lists the blocks defined 
in the xref drawing (Bearing). Select the block Bearing|SIDE and then choose the Add 
button. The block name will be added to the Definitions to Bind list box. Choose the OK 
button to exit the dialog box. AutoCAD will bind the block with the current drawing and a 
message is displayed at the command prompt: 1 Block(s) bound. The name of the block will 
change to Bearing$0$SIDE. You can invoke the Block Definition dialog box by choosing 
the Create Block tool in the Block Definition panel and check the Name drop-down list 
to see if the block with the name Bearing$0$SIDE has been added to the drawing. If you 
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want to insert the block, you must enter the new block name (Bearing$0$SIDE). You can 
also rename the block to another name that is easier to use.

 	 If the block contains a reference to another xref drawing, AutoCAD binds that xref drawing 
and all its dependent symbols to the current drawing also. Once you bind the dependent 
symbols, AutoCAD does not delete them, not even when the xref drawing is detached. For 
example, the block Bearing$0$SIDE will not be deleted even when you detach the xref 
drawing or end the drawing session.

Figure 2-28  The named objects in the Xbind dialog box

	 You can also use the -XBIND command to bind the selected dependent symbols of the xref 
drawing using the command prompt.

6.	 Similarly, you can bind the dependent symbols, Bearing|Standard (textstyle), 
Bearing|Hidden, and Bearing|Object layers of the xref drawing. Click on the plus signs 
adjacent to the respective icons to display the contents and then select the layer or textstyle 
you want to bind and choose the Add button. The selected named objects are displayed in 
the Definitions to Bind list box. If you have selected a named object that you do not want 
to bind, select it in the Definitions to Bind list box and choose the Remove button. Once 
you have finished selecting the named objects that you want to bind to the current drawing, 
choose the OK button. A message indicating the number of named objects that are bound 
to the current drawing is displayed at the command prompt.

Once bound, the layer names will change to Bearing$0$Hidden and Bearing$0$Object. If the 
layer name Bearing$0$Hidden was already there, the layer will be named Bearing$1$Hidden. 
These two layers become a permanent part of the current drawing. Even if the xref drawing is 
detached or the current drawing session is closed, the layers are not discarded. 

CLIPPING EXTERNAL REFERENCES
  Ribbon: Insert > Reference > Clip 		  Command: CLIP    

The Clip tool (Figure 2-29) is used to trim an xref after it has been attached to a drawing 
to display only a portion of the drawing, refer to Figure 2-30. After you have attached an 

xref to a drawing, you can trim it to display only a portion of the drawing by using the Clip tool. 
However, clipping xref does not modify the referenced drawing. On invoking the Clip tool, you 
are prompted to select an object to clip. Select a DWG, DGN, IMAGE, or PDF; the respective 
clipping options will be displayed.  
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Figure 2-29  The Clip tool in the 
Reference panel

Figure 2-30  Using the Clip tool to clip 

You can also invoke the Clip tool by selecting an xref and then right-clicking in the drawing 
area to display a shortcut menu. Next, choose the corresponding clip command from it. For 
example, to clip an attached .dwg file, select the attached .dwg file, right-click, and choose the 
Clip Xref option; the following prompt sequence will be displayed.

Enter clipping option [ON/OFF/Clipdepth/Delete/generate Polyline/New boundary] <New>: 
Press Enter to specify a new clip boundary or enter an option.
Specify clipping boundary or select invert option: [Select polyline/Polygonal/Rectangular/
Invert clip] <Rectangular>: Press Enter to select the Rectangular option, and then specify two 
corners of the rectangular boundary.

You can also right-click in the drawing area at the enter clipping option prompt to display a 
shortcut menu. This shortcut menu displays all the options available at the command prompt 
that can be selected here. All the clipping options available are discussed next. 

New boundary
The clipping boundary can be specified by using the Rectangular, Polygonal, or Select polyline 
option. The Rectangular option generates a rectangular boundary and the Polygonal option 
allows you to specify a boundary of any shape. You can draw a boundary using the Polyline 
tool or the Polygon tool and then, use the Select polyline option to select this polyline as the 
clipping boundary. The Invert clip option inverts the direction of the clipping. For example, 
if the objects outside the clipping boundary are hidden, by default, the Invert clip option will 
hide the objects inside the clipping boundary and display the objects outside the boundary. After 
selecting the Invert clip option, you need to redefine the clipping boundary using any one of 
the options discussed above. The Invert clip option can only be used with the 2D Wireframe 
visual style. If a boundary already exists, AutoCAD will ask you if the old boundary should be 
deleted. You can enter YES if you want to delete the old boundary and define a new one. If you 
enter NO, the old boundary is retained and the Clip Xref tool exits.

ON/OFF
The ON/OFF option allows you to specify whether to display the clipped portion or not. When 
the clipping boundary is off, you can see the complete xref drawing and when it is on, the 
drawing that is within the clipping polygon is displayed.

Delete
The Delete option completely deletes the predefined clipping boundary and the entire xref gets 
displayed. The Erase tool cannot be used to delete the clipping boundary.
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generate Polyline
If you have a clipped boundary, select this option to create a polyline coinciding with the 
boundary of the clipped xref drawing. You can edit the polyline boundary without affecting the 
clipped drawing. For example, if you stretch the boundary, it does not affect the xref drawing. 
The edited boundary can be used later to specify a new clipping boundary.

Clipdepth
This option allows you to define the front and back clipping planes for 3D xref objects or 
blocks. The objects between the front and back planes will be displayed, refer to Figure 2-31 
and Figure 2-32. In the figures that follow, the clipping boundary is defined aligned to the front 
face of the object, and therefore, the clipping planes will get defined parallel to it. The xref 
must contain a clip boundary before specifying a clip depth. If you use the Clipdepth option, it 
prompts you to specify a front clip point and a back clip point. Specifying these points, creates a 
clipping frame passing through them and parallel to the clipping boundary. If the front clipping 
plane is specified behind the back clipping plane, AutoCAD displays an error message and the 
clipdepth is also not applied. The Distance option for specifying the front or back clip points 
creates a clipping plane at a specified distance from the clipping boundary parallel to it. The 
Remove option removes both the front and back clipping planes and the entire object is visible.

Figure 2-31  3D xref object before clipping Figure 2-32  3D xref object after clipping

Similarly, you can clip the other underlaid xrefs. The options available for clipping the underlaid 
Xrefs are ON, OFF, Delete, and New Boundary. These options are the same as discussed above.

DISPLAYING CLIPPING FRAME
You can select the appropriate option from the Frames drop-down list in the Reference panel 
of the Insert tab, refer to Figure 2-33, to turn on or off the display of clipping boundary of all 
clipped Xrefs. If there are multiple underlays of different file types and you have set different 
frame settings for each file type, then the Frames vary button will be displayed in the Reference 
panel of the Insert tab. You can also use the FRAME system variable to turn on or off the display 
of clipping boundary of all clipped xrefs. When the value of FRAME system variable is 0, the 
clipping boundary will neither be displayed or plotted. When it is 1, the clipping boundary will 
be displayed and plotted. When it is 2, the clipping boundary will be displayed, but not plotted. 
When it is 3 (default), the settings vary for all the clipping boundaries. To control the display 
of frames of individual attached Xrefs, you need to invoke the individual system variables like 
XCLIPFRAME, DGNFRAME, PDFFRAME, and IMAGEFRAME.
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Figure 2-33  Options in the FRAME drop-down list

DEMAND LOADING
The demand loading feature loads only that part of the referenced drawing that is required in 
the existing drawing. For example, demand loading provides a mechanism by which objects 
on frozen layers are not loaded. Also, only the clipped portion of the referenced drawing can 
be loaded. This makes the xref operation more efficient since less disk space is used, especially 
when the drawing is reopened. Demand loading is enabled by default. You can modify its settings 
in the External References (Xrefs) area of the Open and Save tab of the Options dialog box, 
refer to Figure 2-34. You can select any of the three options available in the Demand load Xrefs 
drop-down list in this dialog box. These options are Disabled, Enabled, and Enabled with 
copy. These options correspond to a value of 0, 1, and 2 of the XLOADCTL system variable, 
respectively, and are discussed next.

Figure 2-34  Partial view of the Options dialog box with the Open and Save tab chosen 
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Setting	 Value of XLOADCTL		  Features			    

	 Disabled		     0		  1. Turns off demand loading.

						      2. Loads entire xref drawing file.

						      3. The file is available on the server and other                                                                                                                                            
                                                                      users can edit the xref drawing.

	 Enabled		     1		  1. Turns on demand loading.

						      2. The referenced file is kept open.

						      3. Makes the referenced file read-only for other users.

	 Enabled with copy	    2		  1. Turns on demand loading with the copy option.

						      2. A copy of a referenced drawing is opened.

						      3. Other users can access and edit the original  
					         	     referenced drawing file.

You can also set the value of XLOADCTL at the command prompt. When you are using the 
Enabled with copy option of demand loading, the temporary copies of the xref are saved in 
the AutoCAD temporary files directory (defined in the Temporary External Reference File 
Location folder in the Files tab of the Options dialog box) or in a user-specified directory. The 
XLOADPATH system variable creates a temporary path to store demand loaded Xrefs.

Spatial and Layer Indexes
As mentioned earlier, the demand loading improves performance when the drawing contains 
referenced files. To make it work effectively and to take full advantage of demand loading, you 
must store a drawing with Layer and Spatial indexes. The layer index maintains a list of objects in 
different layers and the spatial index contains lists of objects based on their location in 3D space. 

Layer and spatial indexes are created using the Save Drawing As dialog box. Choose the 
Options option from the Tools drop-down to display the Saveas Options dialog box. Choose 
the DWG Options tab if it is not already chosen and select the type of index from the Index 
type drop-down list. None is the default option selected in the drop-down list. As a result, no 
indexes are created. The other options available are: Layer, Spatial, and Layer & Spatial. Once 
you have selected the type of index to create, choose the OK button to exit the dialog box and 
choose the Save button in the Save Drawing As dialog box to save the drawing with the indexes. 
The INDEXCTL variable also controls the creation of layer index and spatial index and its 
value can be set using the command prompt. The following are the settings of the INDEXCTL 
system variable, and they correspond to the Index type options available in the DWG Options 
tab of the Save as Options dialog box.
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Setting	 Features		  Index Type option	

	 0		  No index created			   None		

	 1		  Layer index created			   Layer

	 2		  Spatial index created			   Spatial

	 3		  Layer and spatial index created		  Layer and Spatial

EDITING REFERENCES IN-PLACE
  Ribbon:  Insert > Reference > Edit Reference		  Command:  REFEDIT	  
  Toolbar:  Refedit > Edit Reference In-Place					   

Often you have to make minor changes in the xref drawing if you want to save yourself 
from the trouble of going back and forth between drawings. In this situation, you can use 

in-place reference editing to select the xref, modify it, and then save it after modifications. The 
following steps explain the referencing editing process.

1.	 To edit in-place, select an external referenced object; the External Reference contextual tab 
will be added to the Ribbon, as shown in Figure 2-35. Choose the Edit Reference In-Place 
tool from the Edit panel; the Reference Edit dialog box will be displayed.

Figure 2-35  The External Reference contextual tab added to the Ribbon

2.	 In the Reference name list box of the Reference Edit dialog box, the selected reference 
and its nested references are listed. Select the specific xref you wish to edit from the list. 

3.   	In the Settings tab of the dialog box, select both the Create unique layer, style, and 
block names and the Lock objects not in working set check boxes. The Display attribute 
definitions for editing check box is disabled by default. In the Identify Reference tab of the 
dialog box, select the Prompt to select nested objects radio button. Choose the OK button 
to return to the current drawing. At the Select nested objects: prompt, select the objects you 
want to modify and press Enter. The objects that have not been selected for modifications 
will become faded. The fading is controlled by the XFADECTL system variable or by using 
the Xref display slider bar in the Display tab of the Options dialog box. You can add or 
remove objects to the working set by choosing the respective tools in the Edit Reference 
panel or by using the REFSET command. Once you have defined a working set, all the 
standard AutoCAD commands can be used to modify them.

4.	 When you choose the Save Changes tool in the Edit Reference panel, AutoCAD displays a 
message: All references edits will be saved. Choose the OK button to return to the drawing 
area. The modifications made are saved in the drawing as well as in the current drawing as a 
reference. On choosing the Discard Changes tool in the Edit Reference panel, the changes 
made will not be saved and the current drawing is redisplayed.  
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Note
In the External References (Xrefs) area of the Open and Save tab of the Options dialog box, 
if you select the Allow other users to Refedit current drawing check box, the current drawing 
can be edited in-place by other users even when it is open and is being referenced by another file. 
This option is selected by default and can also be controlled by the XEDIT system variable. The 
default value of XEDIT is 1 and can be changed using the command prompt.

 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 The _________ are entries such as blocks, layers, and text styles.

2.	 If you use the Insert tool to insert a drawing, the information about the named objects is lost 
if the names are _________, and if the names are _________, the drawing will be imported.

3.	 The ___________ option from the Attach drop-down list of the EXTERNAL REFERENCES 
palette is used to attach an xref drawing to the current drawing.

4.	 The _________ feature loads only that part of the referenced drawing that is required in the 
existing drawing. 

5.	 The _________ option can be used to overcome the problem of circular reference. 

6.	 After selecting the _________ option, the xref is completely removed from the current 
drawing.

7.	 If an assembly drawing has been created by inserting a drawing, the drawing will be updated 
automatically if a change is made in the inserted drawing. (T/F) 

8.	 The external reference facility helps you keep a drawing updated no matter when the changes 
were made in the piece part drawings. (T/F) 

9.	 Objects can be added to a dependent layer. (T/F) 

10.	 The Overlay option ignores the nested references. (T/F).

 Review Questions 
Answer the following questions:

1. 	 Which of the following features is used to reference an external drawing without making 
this drawing a permanent part of the existing drawing?

	       (a) demand loading		  (b) external reference
	       (c) external clipping		  (d) insert drawing
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2.	 If an xref has nested references that cannot be found, which of the following will be displayed 
under the status heading of the List View button in the EXTERNAL REFERENCES palette?

 
		  (a) Orphaned			   (b) Not found
	 (c) Unreferenced		  (d) Unresolved

3.	 Which of the following system variables, when set to 1, will allow AutoCAD to maintain a 
log file (.xlg) for xref drawings?

		  (a) XLOADCTL		  (b) XLOADPATH
	 	 (c) XREFCTL 			   (d) INDEXCTL	

4.	 Which of the following system variables, when set to 0, will not allow the clipping boundary 
to be displayed?

		  (a) XCLIPFRAME	 	 (b) XLOADCTL
		  (c) INDEXCTL			  (d) XREFCTL	

5.	 In the __________ drawings, the information regarding dependent symbols is not lost.

6.	 AutoCAD maintains a log file for xref drawings, if the __________ variable is set to 1.

7.	 It is possible to edit xrefs in-place using the __________ tool.

8.	 You can use the __________ tool to add the selected dependent symbols from the xref drawing 
to the current drawing.

9.	 If the xref drawings get updated, changes are not automatically reflected in the assembly 
drawing when you open an assembly drawing. (T/F)  

10.	 There is a limit to the number of drawings you can reference. (T/F)

11.	 It is not possible to have nested references. (T/F) 

12.	 Like blocks, the xref drawings can be scaled, rotated, or positioned at any desired location. 
(T/F)

13.	 You can change the color, linetype, or visibility (on/off, freeze/thaw) of a dependent layer. 
(T/F)
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Exercise 1  						              Bind Xref
In this exercise, you will start a new drawing and xref the drawings as Part-1 and Part-2, refer to 
Figure 2-36 and Figure 2-37. For assembly, refer to Figure 2-38. You will also edit one of the piece 
parts to correct the size and use the Bind Xref option to bind some of the dependent symbols 
to the current drawing. The parameters of layers for Part-1, Part-2 and ASSEM1 are as follows:

For Part-1, set up the following layers:

Layer Name	 Color		  Linetype

0			   White			   Continuous
Object		  Red			   Continuous
Hidden		  Blue			   Hidden2
Center		  White			   Center2
Dim-Part1		  Green			   Continuous

For Part-2, set up the following layers:

Layer Name	 Color		  Linetype

0			   White			   Continuous
Object		  Red			   Continuous
Hidden		  Blue			   Hidden
Center		  White			   Center
Dim-Part2		  Green			   Continuous
Hatch		  Magenta		  Continuous

For ASSEM1, set up the following layers:

Layer Name	 Color		  Linetype

0			   White			   Continuous
Object		  Blue			   Continuous
Hidden		  Yellow			   Hidden

Figure 2-36  Drawing of Part-1
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Figure 2-37  Drawing of Part-2

Figure 2-38  Assembly drawing after attaching Part-1 and Part-2



2-32		         Advanced AutoCAD 2023: A Problem-Solving Approach, 3D and Advanced
	

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Answers to Self-Evaluation Test
1. named objects, 2. duplicated, unique, 3. Attach DWG, 4. demand loading, 5. Overlay, 
6. Detach, 7. F, 8. T, 9. F, 10. T


